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File >> New >> Document

or command+N

Choose a page size or set a custom width 

and height.

Select an orientation: landscape or portrait.

Decide on a margin size: 3p0 (.5”)

Add a p9 (.125”) bleed for all pages.

Select “facing pages” at the top (if you want 

your document to be set up as spreads).

Press “OK” 

Adding pages to the document using the Pages Palette

Window >>Pages

or press command+F12 to pull up the Pages Palette

Two ways to add pages to your document:

1. click on the master page and drag it to the right of page 1. You will see a dark line which means you’re adding this new 

page AFTER page 1. If you drag it to the left of page 1 you’ll be adding the page before the first page creating, of course, a 

new page 1. Do this over and over again until you get the desired amount of pages.

OR

2. At the top left of the pages palette there is a button with a down 

arrow and three horizontal lines. Click once and you’ll see tons of 

options. Go to “insert pages.” Type in the number of pages you 

want to insert and indicate whether or not you want them to go 

before or after the first page. If you’ve set up a series of master 

pages you can choose which one you’d like to add.

HOW TO CREATE A NEW DOCUMENT
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What is a Master Page?

A master page is like a template. If you have many pages in your document that will look alike (for example, a series of 

pages with the same size picture on them with a caption and a page number all in the same place) creating master pages 

will make your life easier because you won’t have to set up each page the same way over and over again. 

Create a New Master Page:

Decide what form your Master will take and assign an 

appropriate name to stay organized – some books have 

dozens of master pages with minute variations.  Next 

choose how many pages (2 for a standard spread, 

4 or 6 for gatefolds).  You will probably keep your 

document’s page size.

Setting Up Your New Master Page:

Double-click on your new Master Page in the Pages Palette.  This will 

bring you into the world of the master, which exists parallel to and behind 

the scenes of actual design content. A new master will appear as a blank 

spread. In this example, we will set up the master page for a spread with 

two vertically centered 35mm proportion images with page numbers. 

Choose the Rectangle Frame Tool and click on the document.  Create a 

box proportional to a 35mm photograph (1:1.5). Use the Selection Tool to 

grab this frame. Hold Command+Shift while dragging a corner to enlarge 

the frame proportionally. Once frame is appropriate size 

(7.5” x 5.5”), hold the Option key and drag frame edge 

to make exact duplicate. Use the Selection tool to move 

both frames into the vertical and horizontal center of 

each page.

Adding Page Numbers to Your New Master Page:

To add page numbers, choose the Type Tool and drag 

a new text frame.  In the application bar, go to Type >> 

Insert Special Character >> Markers >> Current Page 

Number. The Master Page will now display the Master 

Page “prefix” in the text box, but when the Master 

is applied to a page with design content, the correct 

number will display.

Three Ways to Apply a Master Page to a Page in Your Document:

Click once on the page you want to change. It will turn a color. Hold down the Option key and click once on the Master 

Page you’d like to apply. OR Right-click on a page in the Pages Palette and choose Apply Master to Pages. Select your 

Master and choose the page-range. OR Drag the Master Page onto a page already in the Pages Palette.  

MASTER PAGES
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new document  command + N

close document  command + W

open a document  command + O

group items  command + G

ungroup items  command + shift + G

capitalize selection  command + shift + G

undo  command + Z

cut  command + X

copy  command + C

paste  command + V

paste in place  command + option + shift + V

select all  command + A

place an image  command + D

hug the content  command + option + c

fit image proportionally in box  command + option + shift + e

Palettes

F5	 color swatches  

F6	 color with gradations (percentages of each color)

F7	 layers

F8 	 info

F9	 transform

F10	 stroke

F11	 style sheets

F12	 pages

Moving around your document

use the hand tool in the tools palette (H on the keyboard)

or

press the space bar to get the hand

or

when working with an active text box you can press the option key and you will get the hand

Viewing your document

Full Page	Zoom		  command + 0 (zero)

Full Screen Preview	 shift + W

To zoom in 	 command +

To zoom out	 command -        

To get the positive magnifying glass 	 command-space bar

To get the negative magnifying glass 	 command-option-space bar

To make guides, drag from the rulers into the pasteboard with the black arrow.

To get rid of the guides, press the W key. Don’t do this while working with text – it will insert a W – click out of the text box first. 

KEY COMMANDS
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BLACK ARROW: selection tool

moves around objects, selects objects

WHITE ARROW: direct selection tool

selects art INSIDE objects, edits handles and lines

LINE TOOL: 

hold shift to create straight vertical or horizontal lines

PEN TOOL:

Create or delete points to make organic shapes.

RECTANGLE FRAME TOOL:

(Also makes Polygons and Ellipses)

makes frames, boxes, picture boxes

ELLIPSE TOOL (circle tool):

(Also makes Rectangles and Polygons)

makes circle frames and objects

EYEDROPPER TOOL:

samples colors, tones, and character styles

TYPE TOOL:

makes text boxes, you type into them

THE TOOLS PALETTE

Tools Key Commands

black arrow (selection tool)	 V

white arrow (direct selection tool)   A

text tool   T

picture box   F

pen tool    P

***each tool corresponds to a key on the keyboard. If you place your curser 

over a tool for a few seconds a window will pop up to tell you the name of the 

tool and it’s key on the keyboard.
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Character

The Character Palette is the home base for typographical design and decision-

making. Here you’ll choose a Font Family (Helvetica, Trade Gothic, Garamond, 

Bodoni, etc), its Font Style (Medium, Bold, Oblique, Light, etc), and its size. Font 

spacing describes the distance between each line of type. Font height and width 

should probably remain at 100%. Leading describes the amount of s p a c e 

between each typed character. Position moves type up or down – this is how you 

create a super-scripted or sub-scripted characters.

Paragraph

The Paragraph Palette allows the structure and form of each paragraph to be 

adjusted. Text can be aligned Left, Center, or Right. Justified text will act similarly, 

except that every line will be equal to the width of its container text box. An indent 

describes the amount of space between the edge of a text box and edge of the 

text. A First-Line Indent, in contrast, describes the amount of space between 

the edge of a text box and the first letter of the first line of a paragraph. This 

is like pre-setting a tab. Space Before allows you to increase or decrease the 

amount of space between lines of type seperated by a hard-return. Whereas a 

soft-return uses will inherit the Font-spacing determined in the Character Palette. 

A hard-return (enter) is a paragraph break, beginning a new paragraph. A soft-return (shift+enter) allows a line-break within 

a paragraph without starting a new paragraph. Space After also allows you to increase or decrease the amount of space 

between paragraphs in a single text box; it sets the amount of space (in addition to the Font spacing) after a paragraph. A 

drop cap allows the first letter of a paragraph to automatically enlarge to the height of your specified number of lines of text.

Swatches

The Swatches Palette is color central in InDesign. Swatches allow you to preset 

and pre-mix your own color in CMYK, RGB, LAB, or Pantone. In print publication, 

always create swatches of color in CMYK or choose a pre-made Pantone color. 

To create a color swatch, click the down arrow in the top right corner or click the 

new swatch button at the bottom of the Swatches Palette (and double click the 

new duplicated swatch). In the New Color Swatch window, Color Type should be 

Process.  Color Mode should be CMYK.  Then, mix it up!

Font Family

Font Style

Font Size

Spacing

Leading

Position

Alignment

Justification

Indent

First-Line Indent

Space Before

Space After

Hyphenation

Drop Cap

OTHER PALETTES
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Stroke

The Stroke Pallete is useful for adding an accent to any line or outline. For 

instance, let’s say you want to create an arrow.

First, choose the Line tool, and draw your line. If you want it to be a straight 

line, hold the Shift key while dragging. If, by default, your Stroke Weight is set 

to 0 pts your line will disappear as soon as you click away. You can find it again 

by dragging a selection with the Selection Tool or by holding Command while 

clicking in the area where you drew your line.  Holding Command while clicking 

allows your selection to cycle through the various layers in the area of the 

document where you are clicking. Select your line, and go to Window > Stroke. 

This will open the Stroke Palette.  Now type in a weight or click the up arrow 

to the left of the 0 pt until your line is as thick as you want it. Now you’ll have a 

line, but there will not be any arrows at its end. To create an arrow head, click the Start or End drop down menus and choose 

the type of effect you want to apply to the ends of your line. Start describes the end of the line where you started dragging. 

End describes the end of the line where you released your mouse button.  The Stroke Palette also allows you to change the 

appearance of the line beyond its thickness or its start and end symbols.  Select your line and choose the Type dropdown 

menu on the Stroke Palette. This will allow you to create, for instance, a dotted line. These same effects can be used not only 

on lines, but on boxes, ovals or other frames. The Stroke palette screenshot above has a 2pt stroke on its frame.

Text Wrap

The Text Wrap Palette allows you to build in padding around an object, such as an 

image frame or text box.  This is useful when interspersing images within or 

near text.  An image without text wrap that is placed into a region with text 

will either cover the text or be covered by the text, depending on the layer 

hierarchy. The same image frame, with text wrap, will interact with with 

the text dynamically, meaning that if you move the image frame the text 

placement will also change, flowing or “wrapping” around the frame based 

on your settings. The arc to the left has .125 inches of text wrap around the 

“object shape.”  The Text Wrap Palette screen shot to the right has 0.1875 

inches of padding wrapped around all four sides of its “bounding box”. Without text wrap, this text would be either 

disappear behind the image or be unreadable on top of it. To vary the wrap on each side of an image, click the chain-link 

button so that it is no longer dark grey; this will allow you to change the text wrap setting disproportionately. 

OTHER PALETTES
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Styles Palettes

Working with type, especially with a lot of type, will require you to use paragraph and character styles.

You can, of course, not use style sheets but if you do they will make your life much easier and faster.

Style Sheets; Paragraph Styles

The best way to work with style sheets is to first have a block of copy and style it as you wish. 

For example:

Then go to Window >> Styles >> PARAGRAPH STYLES 

Highlight the first line you want to style and then press once on the little arrow at the top right of the paragraph styles 

window and click “New Paragraph Style.”

TITLE OF PHOTO
Photographer name goes here

medium medium medium
extra info maybe goes here and here

Paragraph Styles refer to the style of an entire PARAGRAPH. 

This paragraph can be one line long or 500 words long.

For words or individual letters within a paragraph you will use 

Character Styles.

Because you have already picked the style of this type you don’t have to worry about the options on the left. 

All you have to do is name your style and press ok. Do this for the rest of the lines of your text block. 

Try to name the different styles in such a way that is easy for you to remember and apply. 

To apply your style to the rest of your text do the 

following:

1. Open up the Paragraph Styles palate and make 

sure, “No Paragraph Style” is highlighted.

2. Go to your text and highlight the paragraph you 

want to style. 

3. Click once on the style you want to apply. 

If you make a mistake and click on the wrong style 

just click once on the other one that you want. 

You don’t have to go back to No Paragraph Style. 

OTHER PALETTES
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Paragraph Styles continued

If you need to change or edit the paragraph style you have created make sure you’re out of the text box  

(ie: make sure no text is selected and your cursor is not within any text on the page). Then do one of the following things:

1. Double click on the style you want to change and the “Paragraph Style Options” box will come up.

2. Click once on the style you want to change so that it’s highlighted and then go to the arrow at the top left corner  

of your paragraph styles palate. Click once on that arrow to bring up it’s options.  

Then go down to “Style Options” and the “Paragraph Style Options” box will come up.

You can then edit your style as you wish by choosing from one of the options listed at the left. 

After you’ve made your changes you will notice that every piece of text that had been styled with the old  

version of the style you’ve just changed will now become the new style.

Placeholder Text

An automatic function that will save a lot of time is FILL WITH PLACEHOLDER TEXT. This can be found in the  

Type drop down menu. If you’re designing a page and just want to fill it with dummy copy do the following:

1. Create a text box

2. While it’s selected, ie: when the cursor is in it, go up to TYPE > Fill with Placeholder Text.

3. Your text box will fill with lorem ipsum nonsense type along the lines of “Rorae verovitati rerum atemporpos”

**Special note regarding placeholder text and text in general**

When you create a text box in InDesign if you have a character style or paragraph style selected any type you put into this 

box will take that style. Any placeholder text you put in will take the style that is selected.

Anything you type in will take the style that is selected.

Glyphs

The Glyphs Palette allows you to insert a special character (such as a letter with an accent) into your copy. Select the char-

acter you want to replace with your cursor, then go to TYPE > GLYPHS. 

1. At the bottom of the Glyphs window you can 

pick the typeface you’re currently working in or 

want the accent to be in.

2. Find the accent you want and double click 

on it. Close the Glyphs window. Your accented 

letter will be where your cursor had been.

3. This also works with any symbols you might 

want to place in your text like a copyright or 

trademark symbol.

OTHER PALETTES
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Keyboard keys: what’s what and how to execute a keyboard command 

Keyboard commands (except for the tool keys) are always in pairs of two or three or sometimes four. When you see the 

symbols for the different keyboard commands they can look like heiroglyphics so here is a brief rundown of what’s what.

This is the COMMAND key and is located  

to the immediate left and right of the space bar.

This is the OPTION key and is located next to the command key.

This is the SHIFT key and is located (on the left) directly under the 

caps lock key and (on the right) directly under the return key.

When you see a line up of symbols as in the above example for “Package...” the way to execute the command (and this 

goes for ANY command whether it’s “save” or “open” or “close”) is to press the symbol keys down FIRST and, while hold-

ing them down with one hand, use the other hand to press the letter key once. 

For example: to execute the “package...” command I hold down with my left hand the command, option and shift keys 

(it doesn’t matter what order you press them in) with my thumb, index and middle finger accordingly. While holding these 

keys down with my left hand I use my right index finger to press whatever key is needed, in this case the “P” and then I let 

go of the keys I’m holding down with my left hand.

Window shortcuts

Keyboard commands will make you infinitely faster and more efficient. Most windows (Pages, Color, Style Sheets, etc) have 

a keyboard command that brings them up and takes them away. If you go to Window at the top of your screen you will see 

the list of windows you can bring up and their commands.

Moving objects from page to page

If you have an item that you want to move from one page to another and you want it to be in the exact same space on both 

pages do the following:

1. Using the black arrow, select the object you want to copy, and press command + C. 

2. Go to the page you want to copy the object to and press Command + Option + Shift + V.  

This is the “Paste in Place” command and your copied object will be pasted into the same spot on the second page as it 

was on the first.

Page Numbers

Page numbers are very easy. If you have a document that requires page numbers simply do the following:

1. Go to your masters page in your PAGES palate.

2. Double click on it to open it up.

3. Figure out where you want to have a page number.

4. Make a text box

5. Go up to TYPE > INSERT SPECIAL CHARACTER >AUTO PAGE NUMBER

INDESIGN TIPS & TRICKS
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Guides

If you have a spread and you want to drag a horizontal guide down from the top of the page and want the guide to go 

across both pages of your spread and not just the left or the right hold the command key down while you drag the guide 

away from the ruler.  

Aligning Objects

The Align Pallette is a simple way to get objects in a layout to line up exactly. If you have three boxes and they are all the 

same size and you want them to have equal distance between them and line up at the same level you can do the following. 

1. Using the black arrow select all three boxes.

2. Press the SHIFT key and then the F7 key. This brings up 

the ALIGN box. 

3. While your objects are selected click on one of the buttons 

under the heading “Align Objects.” The buttons give you the 

option to align the left sides, the centers vertically, the right 

sides, the tops, the bottoms, and the centers horizontally. 

4. If you want a specific space between each box click the 

“Use Spacing” button which is right at the bottom under 

“Distribute Spacing” and type in the amount of distance you 

want between each box, such as .25” for a quarter of an 

inch. Then select the boxes again and press one of the but-

tons under “Distribute Spacing”. The one on the left distrib-

utes the boxes vertically and the one to the right distributes 

the boxes horizontally.

How to see your pictures better

Navigate to View > Display Performance 

You have three options for seeing your photos. To make your document quick and still be able to see your photos, you 

should view your pictures at “Typical.” This will keep your photos at a low viewing resolution. They have not been changed 

in any way—don’t worry! If you have a photo that you want to see in it’s actual resolution click on the photo and choose 

“High Quality Display.” This will show you your art as you view it in photoshop in it’s full resolution. If you structure your 

whole document to show all of your pictures as high quality then moving around will be very slow. Choosing “Optomized” 

display makes each photo into a gray box. 

INDESIGN TIPS & TRICKS
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leading window in CONTROL window

up and down leading arrows

tracking window

up and down tracking arrows

Leading is the 

space between lines.

To change the leading in a block of text:

1. highlight entire text block and in the CHARACTER window (command T)  

press the up or down arrows to change the leading.

2. highlight entire text block and press the OPTION key and the up or down arrow 

on the keyboard.

3. highlight entire text block and change the leading in the CONTROL window 

at the top of your screen.

Tracking is the space b e t w e e n  letters.

1. highlight what you want to change and in the CHARACTER window press 

the up or down arrow in the tracking window to change the space between the letters.

2. highlight what you want to change and press the OPTION key and either 

the left or right arrow on the keyboard.

3. highlight what you want to change and press the up or down arrow in the CONTROL window

at the top of your screen. 

CHARACTER WINDOW

leading window

up and down leading arrows

tracking window

up and down tracking arrows

WORKING WITH TYPE IN INDESIGN
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To change the type size you can do one of the following things:

1. highlight the word or words you want to change and in the CHARACTER window

either type in the point size you want or use the up or down arrow to pick a size.

2. highlight the word or words you want to change and in the CONTROL window at the top of 

your screen change the type size to what you want by either typing in a number or using the up or down arrows.

3. highlight the word or words you want to change and on the keyboard hold down the 

COMMAND and the SHIFT keys and then press either the . (period) or the , (comma) key to make the type size go up or down.

To change the type size you can do one of the following things:

1. highlight the word or words you want to change and in the 

SWATCHES window click once on the color you want 

the type to be. (You can find the SWATCHES palatte 

by pressing F12 on the keyboard or you can find it under  

WINDOW at the top of the screen) 

TYPE SIZE 

TYPE COLOR
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When you create a text block and start typing into it your computer will default to a 

typeface like Times or Helvetica (whatever it’s set to default to). To change they typeface to  

what you want  you can do one of two things:

 

 

Below the typeface window in both the CHARACTER and the CONTROL windows the 

typeface will show it’s different varieties such as, italic, bold, small caps, etc. 

You choose whatever option you want for your type in this window in the same way that you would pick a typeface.

Certain typefaces are good for body copy (long texts) and some are better for headlines. 

You don’t have to follow any rules for what you do but some typefaces are more  

legible than others at specific sizes.

Here are some typefaces that are good for body copy or captions: 

	 Garamond 3 (medium)

	 Bodoni Std (book)

	 Goudy Old Style Std (regular)

	 ITC Franklin Gothic Std (book)

	 Trade Gothic (light or medium)

Some typefaces that are good for headline or large display type:

	 ITC Franklin Gothic Std (demi, condensed or EXTRA COMPRESSED)

	 Trade Gothic (bold or BOLD NO. 2)

	 DIDOT 
	 LIGHTLINE GOTHIC
 

more type examples next page

TYPE FACE 

1. highlight the text you would like to change and in the CHARACTER window press 

the blue up /down arrow to bring up your list of typefaces and pick one.

2. highlight the text you would like to change and in the CONTROL window press the 

blue up or down arrow to select your typeface.
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NYU PHOTO 2011  trade gothic bold condensed 20

NYU PHOTO 2011  itc franklin gothic std book extra compressed

NYU PHOTO 2011  Itc franklin gothic std medium condensed

NYU PHOTO 2011  itc franklin gothic std heavy

NYU PHOTO 2011  gill sans light

NYU Photo 2011  rosewood std fill

NYU PHOTO 2011  engravers lt std regular

NYU PHOTO 2011   lightline gothic regular

NYU PHOTO 2 011   didot

NYU Photo 2011  bodoni std poster

NYU Photo 2011  bodoni std poster compressed

NYU Photo 2011  corvinus skyline

NYU PHOTO 2011  strada

Examples of headline or display type.
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Ismodo consequam quis num velissim quisit volore ea feu 
feui blam do corem init, quisit praessendre et alit vullutat 
nulla at. Iquipisisi blaorer iustrud eu feuis dolorti nciduis 
ese conullan velent luptat. Ming esenibh et, veliquam, 
sequism oloreet lutpat augiam quat.Ip eugait lum quis aci 
tat praestin eu facincil ullutpatem vendio del del dio od 
tion endip enit ad do od ex er ipis nit velendit aliquat. 
Duisim ipisissit lut ullummolore cortio.

Ismodo consequam quis num velissim quisit volore ea feu feui blam 

do corem init, quisit praessendre et alit vullutat nulla at. Iquipisisi 

blaorer iustrud eu feuis dolorti nciduis ese conullan velent luptat. 

Ming esenibh et, veliquam, sequism oloreet lutpat augiam quat.Ip 

eugait lum quis aci tat praestin eu facincil ullutpatem vendio del del 

dio od tion endip enit ad do od ex er ipis nit velendit aliquat. Duisim 

ipisissit lut ullummolore cortio. 

Goudy Old Style Std regular 10/14

Bodoni book std 9/14

Ismodo consequam quis num velissim quisit volo-
re ea feu feui blam do corem init, quisit praessendre 
et alit vullutat nulla at. Iquipisisi blaorer iustrud eu 
feuis dolorti nciduis ese conullan velent luptat. Ming 
esenibh et, veliquam, sequism oloreet lutpat augiam 
quat.Ip eugait lum quis aci tat praestin eu facincil 
ullutpatem vendio del del dio od tion endip enit ad 
do od ex er ipis nit velendit aliquat. Duisim ipisissit 
lut ullummolore cortio.

Ismodo consequam quis num velissim quisit volore ea feu feui 

blam do corem init, quisit praessendre et alit vullutat nulla at. 

Iquipisisi blaorer iustrud eu feuis dolorti nciduis ese conullan 

velent luptat. Ming esenibh et, veliquam, sequism oloreet lutpat 

augiam quat.Ip eugait lum quis aci tat praestin eu facincil ullut-

patem vendio del del dio od tion endip enit ad do od ex er ipis nit 

velendit aliquat. Duisim ipisissit lut ullummolore cortio.

garamond medium 12/14

Trade Gothic light 9/14 

Ismodo consequam quis num velissim quisit volore ea feu 

feui blam do corem init, quisit praessendre et alit vullutat nul-

la at. Iquipisisi blaorer iustrud eu feuis dolorti nciduis ese 

conullan velent luptat. Ming esenibh et, veliquam, sequism 

oloreet lutpat augiam quat.Ip eugait lum quis aci tat praestin 

eu facincil ullutpatem vendio del del dio od tion endip enit ad 

do od ex er ipis nit velendit aliquat. Duisim ipisissit lut ullum-

molore cortio.

Ismodo consequam quis num velissim quisit volore ea feu feui 
blam do corem init, quisit praessendre et alit vullutat nulla at. 
Iquipisisi blaorer iustrud eu feuis dolor ti nciduis ese conullan 
velent luptat. Ming esenibh et, veliquam, sequism oloreet lutpat 
augiam quat.Ip eugait lum quis aci tat praestin eu facincil ullut-
patem vendio del del dio od tion endip enit ad do od ex er 
ipis nit velendit aliquat. Duisim ipisissit lut ullummolore cor tio.

ITC Franklin Gothic Std book 9/14

Gill Sans light 9/14

Ismodo consequam quis num velissim quisit volore ea feu 
feui blam do corem init, quisit praessendre et alit vullutat 
nulla at. Iquipisisi blaorer iustrud eu feuis dolorti nciduis ese 
conullan velent luptat. Ming esenibh et, veliquam, sequism 
oloreet lutpat augiam quat.Ip eugait lum quis aci tat prae-
stin eu facincil ullutpatem vendio del del dio od tion endip 
enit ad do od ex er ipis nit velendit aliquat. Duisim ipisissit 
lut ullummolore cortio ullutpatem vendio del del dio od tion 
endip enit ad. 

Adobe Caslon regular 10/14

Examples of body copy styles.

*Below each block of type is the type face with it’s size/leading.
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Examples of caption styles.

*Below each block of type is the type face with it’s size/leading.

Examples of captions from previously published works.

Photographer Name, Title of Photo, 2010

Photographer Name, Title of Photo, 2010

Photographer Name, Title of Photo, 2010

ITC franklin gothic demi and demi oblique, 9pt.

Garamond 3 medium and italic, 9.5pt.

Adobe caslon pro regular and italic, 9.5pt.

This caption was done in ITC franklin gothic and 
describes three pictures with directionals plus gives 
the copyright info small at the bottom. This caption 
was from Aperture magazine.

This caption was done in garamond 3 bold and is a 
descriptive caption with directionals in parentheses.
This caption was from CR magazine.

This caption was done in minion pro for Andrew 
Moore’s Detroit book. 

THIS PAGE, TOP: Jasmijn Towards the Light, 2008, 58 x 48 in.;  

BOTTOM: Jasmijn Nude, 2008, 58 x 48 in.; OPPOSITE: Fay Painting, 

2009, 48 x 48 in.

All images © Richard Learoyd; Jasmijn images courtesy Fraenkel Gallery, San Francisco; all other images courtesy 
McKee Gallery, New York

Subha Barry (with husband, Jim 

Barry, and on opposite page with 

friend Ruby Suresh) is known for 

her dedication to others. 

Yard, Car Wash Café, East Jefferson Avenue
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1. Adding Text or filling with place holder text

Go to the “T” tool in your tools palatte. 
Click on your page and drag to make a text box.

Now you can either type directly into this box

OR 

Copy text from a Word document or other source

OR 

Right click with your mouse with your cursor in the text box. 
scroll to “FILL WITH PLACEHOLDER TEXT”

Filling a text box with “placeholder text” fills a box with dummy copy  
and can be worked with and styled just like regular text.

2. What is that red box in the corner of my text box 
and how do I get rid of it?

The red box signals that you’ve got “runover” text.

Your text isn’t GONE it just doesn’t fit into the text box you made.

You can either:

Open up or resize the text box to accomidate more words

OR

Change the point size and leading of your type to make the text smaller so that more of it fits into the text box

OR

You can CONNECT the text to another text box:

	 • make another text box next to your original. **make sure it’s empty of text**

	 • switch tools to the black arrow tool (selection tool)

	 • with the black arrow tool, click once on the red box, then once into the empty text box.

	 • the text “threads” or connects from one box to another.

You can also delete all text after the red box, even though it’s hidden.

	 • place your cursor after the last word or letter in the text box that appears before the red box.

	 • ON A REGULAR KEYBOARD: press command–shift with your left hand, then press the “end” key with your right fore-
finger. The “end” key is above the arrows on most keyboards. 

	 • ON A LAPTOP (or laptop-like keyboard): press command–fn–shift with your left hand, then press the  arrow

3. How do I make columns?

• Make a text box

• On the keyboard press: command B.  
Or go up to the object menu and to TEXT FRAME OPTIONS

• Where it says “columns” type in the number of columns you want.

• The “gutter” refers to the space between the columns. 
As a rule I put MORE space between columns of justified text and  
LESS space between columns of flush left (left aligned) text.

TYPOGRAPHY TIPS & TRICKS
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Ectem dunt lutpat ipit luptat lore vulluptatem 

digna am, con hendips uscidui ssectet praesto 

dolobor periuscidunt utpat ilisi. Unt nos nulla 

facipsu stisi. Ud ex esto con voluptat nit iure tat 

num iriusci piscing exerit nulput accumsan ullan 

et utpat iustrud te do dit num at. Volore dolore 

molore dolor sed euis eugue minim il del incid-

unt aute magnibh euipis ercilis accummy nulla 

feuguer ciduip eu facidunt numsan henisi. Nit 

volum vel ipsuscillam, quatum inim dit, conseni 

ssequam quisit autat il ut iure min hent ven-

digna adio consequ iscilit prat, con utpat. Duis-

modit vulla ad magna facilis ad dunt dui bla con 

hendio conse te feu facidui sciliquam inis nulla 

facin velestrud tionse dolorer sequatio commy 

nulputet, con henibh et utatie dolent la feuis-

sit alit vent vullam vullam dolobore doluptat, 

quipit la feummodolor aliquat et wisisisisl utem 

adignibh eu faccum autet, commolore feugiam 

duismolorem ipis num vercilit iuscilit augue 

min eugait wisi tatem zzriurerit la consed tat aci 

enit lan eugait ver sum iril del el eugue te tem 

volendrem nonsed estio diate ver senis nulluptat. 

Em aliquis nim eros nulputat eliquisi blam nos 

niat inciliquis num illum eriurem nonsent eu 

feum quam, quam, consequatum vulla feuis at, 

quiscilla faccum vullaor sumsan hendigna adi-

on endigna core ming exero dit euisl iuscinci 

erostio et luptat illaore conse minisl utat ero cor 

si.Tuercidunt volut ver alit vullam, consequat 

at. Nit lut am, consequis dunt adignibh eugiat. 

Del ut ad magnibh euisim dolutpat il ut laorero 

enis num ercil dolobore magna feui bla facidunt 

deliquamet luptatinim alisl dolestrud doles-

endre min ullandrem ex eu facidunt etuerosto 

ercipsuscing euis adipsum aliscincipis nostrud 

magna feugiat accum aut nulluptat endignim 

irit esequis cipsusc ilissi ex eum augiat lore mod 

dolumsa ndignim digna facin utem nonsed diam 

alis am quis adiam in venim il utet, quis am il 

dolenisi eu facilis num at dunt venibh euipit, vel 

euis adit praesed et at irit, quatin vent ipsustrud 

dignis acidunt wis dionsequis augiat. Lor si.

Veliquam, consed dolenit lorperil do elestrud 

tionullam irilit alit voluptatum dionullan vel 

ute eros ad exerat, sustisi etue dolore feummo-

lore mincill uptat, suscilit, consequatet wisis 

dolobor erilla conse eum endreros aliquipsum 

zzrit am nulla ad del et ut loboreet ex eugiamc 

onsequi smodipi smolobor sent in hendre feu-

gue con hent ad ting eugiatie te delent adiatem 

nosto dolobore magna faccum dolor iusci bla 

aute consenibh eros acillaore do mincill uptat, 

suscilit, consequatet wisis dolobor erilla conse 

eum endreros aliquipsum zzrit am nulla ad 

del et ut loboreet ex eugiamc onsequi smodipi 

smolobor sent in hendre feugue con hent ad ting 

eugiatie te delent adiatem nosto dolobore magna 

faccum dolor iusci bla aute consenibh eros acil-

laore doleleniamet ulput atem iureet loboreetum 

quatinit, se ero doloborper irit deliquat. Em zzril 

exerit am iuscidunt amcommy amcommy nulla-

neugai ullam delenisi ullam delenis ullam dele-

nisit adit nim inibh ea facilit ipisi.

An example of good balance between the spaces on the sides of the 
columns, between the columns, and between the lines of the text.
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Ectem dunt lutpat ipit luptat lore vulluptatem 
digna am, con hendips uscidui ssectet praesto 
dolobor periuscidunt utpat ilisi. Unt nos nulla 
facipsu stisi. Ud ex esto con voluptat nit iure tat 
num iriusci piscing exerit nulput accumsan ullan 
et utpat iustrud te do dit num at. Volore dolore 
molore dolor sed euis eugue minim il del incidunt 
aute magnibh euipis ercilis accummy nulla feuguer 
ciduip eu facidunt numsan henisi. Nit volum vel 
ipsuscillam, quatum inim dit, conseni ssequam 
quisit autat il ut iure min hent vendigna adio 
consequ iscilit prat, con utpat. Duismodit vulla 
ad magna facilis ad dunt dui bla con hendio conse 
te feu facidui sciliquam inis nulla facin velestrud 
tionse dolorer sequatio commy nulputet, con 
henibh et utatie dolent la feuissit alit vent vullam 
vullam dolobore doluptat, quipit la feummodo-
lor aliquat et wisisisisl utem adignibh eu faccum 
autet, commolore feugiam duismolorem ipis num 
vercilit iuscilit augue min eugait wisi tatem zzri-
urerit la consed tat aci enit lan eugait ver sum iril 
del el eugue te tem volendrem nonsed estio diate 
ver senis nulluptat. Em aliquis nim eros nulputat 
eliquisi blam nos niat inciliquis num illum eri-
urem nonsent eu feum quam, quam, consequatum 
vulla feuis at, quiscilla faccum vullaor sumsan 
hendigna adion endigna core ming exero dit euisl 
iuscinci erostio et luptat illaore conse minisl utat 
ero cor si.Tuercidunt volut ver alit vullam, con-
sequat at. Nit lut am, consequis dunt adignibh 
eugiat. Del ut ad magnibh euisim dolutpat il ut 
laorero enis num ercil dolobore magna feui bla 
facidunt deliquamet luptatinim alisl dolestrud 
dolesendre min ullandrem ex eu facidunt etueros-
to ercipsuscing euis adipsum aliscincipis nostrud 
magna feugiat accum aut nulluptat endignim 
irit esequis cipsusc ilissi ex eum augiat lore mod 
dolumsa ndignim digna facin utem nonsed diam 
alis am quis adiam in venim il utet, quis am il do-
lenisi eu facilis num at dunt venibh euipit, vel euis 
adit praesed et at irit, quatin vent ipsustrud dignis 

acidunt wis dionsequis augiat. Lor si. Veliquam, 
consed dolenit lorperil do elestrud tionullam irilit 
alit voluptatum dionullan vel ute eros ad exer-
at, sustisi etue dolore feummolore mincill uptat, 
suscilit, consequatet wisis dolobor erilla conse 
eum endreros aliquipsum zzrit am nulla ad del et 
ut loboreet ex eugiamc onsequi smodipi smolobor 
sent in hendre feugue con hent ad ting eugiatie te 
delent adiatem nosto dolobore magna faccum dolor 
iusci bla aute consenibh eros acillaore doleniamet 
ulput atem iureet loboreetum quatinit, se ero dolo-
borper irit deliquat. Em zzril exerit am iuscidunt 
amcommy nullandigna facilit vel eugait, consequ 
amcommod eugait venim zzrit nulput in ea faccum 
ad te molorer ostrud eugait adit nim inibh ea ftrud 
magna feugiat accum aut nulluptat endignim 
irit esequis cipsusc ilissi ex eum augiat lore mod 
dolumsa ndignim digna facin utem nonsed diam 
alis am quis adiam in venim il utet, quis am isi.
Veliquam, consed dolenit lorperil do elestrud tio-
nullam irilit alit voluptatum dionullan vel ute eros 
ad exerat, sustisi etue dolore feummolore mincill 
uptat, suscilit, consequatet wisis dolobor erilla 
conse eum endreros aliquipsum zzrit am nulla ad 
del et ut loboreet ex eugiamc onsequi smodipi 
smolobor sent in hendre feugue con hent ad ting 
eugiatie te delent adiatem nosto dolobore magna 
faccum dolor iusci bla aute consenibh eros acillaore 
doleniamet ulput atem iureet loboreetum quatinit, 
se ero doloborper irit deliquat. Em zzril exerit am 
iuscidunt amcommy nullandigna facilit vel eugait, 
consequ amcommod eugait venim zzrit nulput in 
ea faccum ad te molorer ostrud eugait adit nim 
inibh ea facilit ipisi.

An example of bad balance.

Columns are too close to the trim, lines of type too tight,  
gutter between columns is too big. 

COLUMN WIDTH
As a general rule do not make your columns of text too wide.
It is too hard for the reader’s eye to travel down a line and then 
track back to the next line under what they have just read.

If you DO want to make wide columns of text raise the point size 
and open the leading.
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Ectem dunt lutpat ipit luptat 

lore vulluptatem digna am, con 

hendips uscidui ssectet praesto 

dolobor periuscidunt utpat ilisi. 

Unt nos nulla facipsu stisi. Ud 

ex esto con voluptat nit iure 

tat num iriusci piscing exerit 

nulput accumsan ullan et utpat 

iustrud te do dit num at. Volore 

dolore molore dolor sed euis 

eugue minim il del incidunt aute 

magnibh euipis ercilis accummy 

nulla feuguer ciduip eu facidunt 

numsan henisi. Nit volum vel 

ipsuscillam, quatum inim dit, 

conseni ssequam quisit autat il 

ut iure min hent vendigna adio 

consequ iscilit prat, con utpat. 

Duismodit vulla ad magna facilis 

ad dunt dui bla con hendio conse 

te feu facidui sciliquam inis nulla 

facin velestrud tionse dolorer 

sequatio commy nulputet, 

con henibh et utatie dolent la 

feuissit alit vent vullam vullam 

dolobore doluptat, quipit la 

feummodolor aliquat et wisisisisl 

utem adignibh eu faccum 

autet, commolore feugiam 

duismolorem ipis num vercilit 

iuscilit augue min eugait wisi 

tatem zzriurerit la consed tat aci 

enit lan eugait ver sum iril del el 

eugue te tem volendrem nonsed 

estio diate ver senis nulluptat. 

Em aliquis nim eros nulputat 

eliquisi blam nos niat inciliquis 

num illum eriurem nonsent eu 

feum quam, quam, consequatum 

vulla feuis at, quiscilla faccum 

vullaor sumsan hendigna adion 

endigna core ming exero dit 

euisl iuscinci erostio et luptat 

illaore conse minisl utat ero 

cor si.Tuercidunt volut ver alit 

vullam, consequat at. Nit lut 

am, consequis dunt adignibh 

eugiat. Del ut ad magnibh 

euisim dolutpat il ut laorero 

enis num ercil dolobore magna 

feui bla facidunt deliquamet 

luptatinim alisl dolestrud 

dolesendre min ullandrem ex eu 

facidunt etuerosto ercipsuscing 

euis adipsum aliscincipis nostrud 

magna feugiat accum aut 

nulluptat endignim irit esequis 

cipsusc ilissi ex eum augiat lore 

mod dolumsa ndignim digna 

facin utem nonsed diam alis am 

quis adiam in venim il utet, quis 

am il dolenisi eu facilis num at 

dunt venibh euipit, vel euis adit 

praesed et at irit, quatin vent 

ipsustrud dignis acidunt wis 

dionsequis augiat. Lor si.

Veliquam, consed dolenit 

lorperil do elestrud tionullam 

irilit alit voluptatum dionullan 

vel ute eros ad exerat, sustisi 

etue dolore feummolore mincill 

uptat, suscilit, consequatet wisis 

dolobor erilla conse eum endreros 

aliquipsum zzrit am nulla ad 

del et ut loboreet ex eugiamc 

onsequi smodipi smolobor sent 

in hendre feugue con hent ad 

ting eugiatie te delent adiatem 

nosto dolobore magna faccum 

dolor iusci bla aute consenibh 

eros acillaore doleniamet 

ulput atem iureet loboreetum 

quatininisim quat duis augait in 

velessim zzrit la feugiat.

An example of good balance between the spaces on the sides of the 
columns, between the columns, and between the lines of the text.

The point size of the text is a little smaller here and there are three 
columns instead of two. The spaces on the left and right of the text 
block are small but the larger space on the bottom compensates.
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1. shift elipse tool makes aperfect circle

2. select type on path T tool

3. choose starting point

4. type on path options (type menu bar) to change the baseline
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TYPE ON A PATH 

1. use pencil tool 

2. select type on path T tool

TYPE IN A SWIRL
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All your files should be well organized and in ONE MAIN FOLDER.

1. Make a main folder for each of your students student’s name on it (Last name_first name)

Inside that make the following folders:

		  -01 CURRENT PAGES

		  -02 FPOs

		  -03 OLD PAGES

		  -04 HI-RES ART

		  -05 TEXTS

2. Inside “01 Current Pages” goes your final layout as well as your packaged InDesign

HOW TO ORGANIZE YOUR FILES
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3. The folder called “02 FPOs” contains just low-res pics for placement only

4. The folder called “03 HI RES ART” contains your finished hi-res pictures that will be linked to the layout when the 

design is finalized.

5. The folder “04 Texts” will contain word or text files, if you have any text on the layout.

HOW TO ORGANIZE YOUR FILES
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REGULAR PRINTING INSTRUCTIONS

1. Go to FILE>Print

At the top of the box pick the printer you will be using.

2. Under GENERAL type in the amount of copies you want to print out

3. Below that click ALL to print out all of your pages or fill in a range of pages

4. Only click SPREADS if you want your document to print as spreads, for

single pages keep it unclicked.

5. Under the Options heading click on “Print Blank Pages” if you have blank pages

in your document, if this isn’t checked off InDesign won’t print your blank pages

6. Under SETUP pick the paper size you want. 

11 x 17 is called a few different things depending on the printer

(B, tabloid, 11 x 17) *Below the paper size drop down menu are width and

height numbers. When you pick a size of paper the width and height show up and

let you know what you’ve picked.*

7. Below that under Options type in the percentage you want your pages printed 

out as. Keep “Constrain Proportions” clicked so that nothing gets funky.

8. Decide on a page position.

9. Under MARKS AND BLEED pick the crop marks you want

10. Keep “Use Document Bleed Settings” checked unless you want to manually

have the printer print past the trim marks. If you want that unchcek that option and 

fill in the amount of space beyond the crop marks you want the printer to print. This

will be represented in your preview window as a pink border around your page.

11. Under GRAPHICS you can tell the printer to send the data as 

“Optomized Subsampling” or “Proxy”.

Optomized Subsampling means the printer links up with your images and you get

a nice print quality but it might be sort of slow.

Proxy means that the printer doesn’t link up to your images and prints a low res

version of your images but it will print quickly.

File >> PRINT

or command + P

HOW TO PRINT YOUR PAGES OUT
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12. Under COLOR MAGANGMENT you can work on syncing your printer

up with your files or your paper to get the best quality possible.

13. Bottom left corner, click on PAGE SETUP.

14. You’ll get a dialog box that asks you to specify the printer and the 

paper size and orientation and scale. Fill these out.

press OK.

15. Next to Page Setup click on the button that says PRINTER

16. Here is where you can be really specific with your printer details.

Under “Copies and Pages” there are many options, go down to 

“Print Settings” and here is where you can specify that type of paper, ink

and quality you want. There are many options here, pick which you think

is best for the type of printing you want to do.

17. Press Print. The document won’t print just yet, you have to press

PRINT again in the bottom right corner of the print dialog box.

HOW TO PRINT YOUR PAGES OUT
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1. File>Print

2. Choose your printer at the top of the box

3. Under GENERAL type in the amount of copies you want to print out

4. Below that click ALL to print out all of your pages or fill in a range of pages

5. Only click SPREADS if you want your document to print as spreads, for

single pages keep it unclicked. *when printing thumbnails for a book it’s good  

to print the pages as spreads so you can see your pages as spreads.*

5. Under the Options heading click on “Print Blank Pages” if you have blank pages

in your document, if this isn’t checked off InDesign won’t print your blank pages

6. Under SETUP choose your paper and orientation.

7. Below that in the “options” section you want to check off THUMBNAILS

Next to that you’ll see options for how many per page. This also determines the size of the thumbnails. As you go through 

the different choices you’ll see your preview window change to reflect what you’ve picked.

8. Follow instructions from here for regular printing.

PRINTING THUMBNAILS

TILING YOUR PAGES

1. File>Print

2. Under the SETUP menu

3. Choose your paper size

4. Choose the best orientation for your document

5. Make the scale 100% (if that’s what you want)

6. Click on the TILE button

7. Keep it on AUTO

8. Change the overlap to a smaller amount like half an inch (3p)

9. Under MARKS AND BLEED pick the kind of crop marks you want

10. Follow regular printing instructions from here.
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1. In Photoshop - Go into Edit Menu - Color Settings

	 - North America General Purpose 2

	 - Gray 1.8

	 - Preserve Embedded Profiles (for all)

2. Go into Edit Menu - Convert to Profile

	 Destination Space

		  - U.S. Web Coated (SWOP) v2

	 Conversion Options

		  - Engine: Adobe ACE

		  - Intent: Perceptual

		  - Use Black Point Compensation and Dither

3. Save image to a “Working Files” folder, keep as either PSD or Tiffs

4. Crop

5. Adjust image size (if needed)

6. Fix any dust spots (If photographer hasn’t)

7. Adjust color to match the match prints from the photographer.

	 - Avoid adjusting contrast and brightness, try to do all work in curves or histograms

	 - Avoid comb effect in the histogram.

	 - Do not lose any blacks or whites

8. Save file.

9. Go to edit menu - Convert to Profile

	 - Double check that Source Space says it is U.S. Web Coated (SWOP) V 2

	 - Under Conversion Options make sure the Intents is Perceptual and Dither is selected.

10. If Image is grayscale, convert from 16-bit to 8-bit

11. Make sure files are named cohesivly 

	 -nameofphotographer_01.tif 

PREPARING FILES FOR PRESS
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1. Make sure your document is absolutely perfect, no spelling errors, etc.

2. If you have any photos that are “bleed” meaning they have no borders and their edges go off the page you have to make 

sure that the edges of your photo go over the edge at least .125”. 

This is the minimum amount. If your photos don’t have the extra bit hanging over the edges you run the risk of your pages 

being trimmed badly and little white hairline borders at the edges of your pages. 

3. Make sure all of your photos are “linked”.

Go to window>links. The links window will pop up and show you a list of all of the photos in your document. If there is a 

question mark next to any of the images then you’ll need to relink them. 

4. Make sure all of your fonts are ok.

Go to type>find font. In this window, basically, it’s the same thing as the links window. If you are missing a font you’ll see a 

question mark next to the font that is missing and you’ll have to make sure your fonts are all turned on.

5. Make sure all of your colors are cmyk.

Check to make sure all images are cmyk. Check to make sure all of the colors you use in your document are cmyk. Print-

ers do not print RGB.

If you are using a Pantone for anything make sure the printer is aware of this and that your job is spec’d out to be a 5 color 

job to include the pantone along with the 4 other colors. Pantone is considered ONE color. If you have a 4-color job PLUS 

a Pantone that equals a 5-color job. If you have only grayscale images PLUS one pantone color this is considered a 2-color 

job (black + pantone = 2 colors). 

6. Make final printouts of your pages at 100% and 50%. The pages can be printed as b/w. The pages at 100% are to show 

the printer exactly the size of the images and positioning of type, etc. Use the pages that are at 50% to mark up anything 

you’d like the printer to be aware of such as the following:

• Type or borders or lines in color, these should be marked and labeled telling the printer exactly what color you’re using. 

If you are using a cmyk breakdown then your note has to show the exact cmyk breakdown. If you’re using pantone colors 

your note should indicate the exact number for the pantone color.

• Retouching. If you have any retouching that you’d like the printer to do then it has to be marked on the printouts and 

explained. 

• Anything special that you think the printer should watch out for, like making sure the photo doesn’t print too dark or too 

light, etc. 

7. Type up a note to go with your printouts to indicate what these printouts and disk are for. This note should have your 

name and contact info in case the printer has any questions. Staple this note to the front of the printouts.

8. Ok, now you’re ready to  “package” the file. Under File go to Package. 

HOW TO ORGANIZE AND SEND FILES TO THE PRINTER
AKA: PREPRESS
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The second window that will pop up is a window asking for printing instructions. Fill out your name, etc. This is pretty 

much a duplicate of the note you’re attaching to the printouts but fill it out anyway, it’s good to be redundant and overly 

careful.

The next window, “Create Package Folder” asks you where the folder should go, what it should be called, and what should 

go into it. This means that InDesign is going to take your document and fonts and pictures and package them all up into 

one file and place it where you want. This window is also where you name the folder. At the bottom of this window you can 

choose whether or not to include the fonts and pictures, etc. by checking off different boxes. 

Next press PACKAGE at the bottom right. The computer (if you’ve chosen to include fonts) will ask you about font copy-

rights, etc. just press OK. You’ll then see a series of windows and progress bars go by and when the program is finished 

you’ll see your folder on your desktop (or wherever you’ve decided to place it).

9. This folder should have everything the printer needs to print out your document. Everything in this folder is a duplicate. 

So you will still have a copy of your document and your art and your fonts on your computer. 

10. This folder should be burned onto a cd or dvd and then sent with your printouts in one package to the printer. 

Some printers want you to upload files to their FTP site. If this is the case it’s best to send the marked up printouts first 

thing (like FedEx) so that the printer gets the job right away after they download your files. 

11. As a precaution I like to keep all of my packaged files with dates on them in a folder (per job) called “Final Files.” That 

way I know exactly what I sent to the printer and when.

12. Some printers want hi-res pdfs of my files. This is fine but it’s good to have the back up “hard copies” of the original 

files. Some printers won’t be able to open your version of InDesign but can accept a pdf. Always check with the printer 

before submitting your job. They always have specs for sending in files. 

The first window that will pop up tells you if there are 

any errors indicated by a yellow sign that will appear 

next to the Links or Fonts.

FONTS

LINKS

PACKAGING AN INDESIGN FILE
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BOOKBINDING: HOW TO KETTLE STITCH

1. Fold paper into signatures. Poke holes in the spine with a needle slightly smaller 
than the width of the thread.

-The size of the book will determine the number of holes
needed. You will need at least one at each end, and one on either side of every 
piece of tape you use.

2. Here is a diagram of where the holes could be placed. You could use as many 
holes as you feel necessary, as long as it is an even number.

3. Thread your needle with ample thread and a knot at one end. Start sewing from 
the outside the outside of the book, so the knot ends up in the spine.

4. Keep sewing and complete the first stitch.

5. Sew over the pieces of tape, using the same stitch as the first one. Make sure 
the thread is tight and straight. Continue down the spine till you reach the end.
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BOOKBINDING: HOW TO KETTLE STITCH

6. When you have finished the first signature, don’t cut the thread or tie a knot. 
Continue on to the second one. Place them side by side and repeat the same 
steps. Make sure your string is always taut, so the pages with stick together.

7. When you get to the tape, sew over it in the same way you did at the very 
beginning. In the end the tape will be sewn into all the Signatures to bind them.

8. When you get to the end of the second signature you will start the kettle stitch.

9. Loop the thread around the piece sticking out, at the very beginning of the 
first signature.

10. Bring the needle around completely and pull it through the loop created.
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BOOKBINDING: HOW TO KETTLE STITCH

14. Binding complete!

11. If you are adding a third signature, continue on sewing and complete a 
third signature just like the first two. If not, tie a simple, neat knot and snip 
the end of the thread.

12. If you added a third signature, when you get to the end, loop your needle 
through the stitch that connects the first and second signature.

13. Again here you can tie a small, neat knot or continue and add another signature.


